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 Copyright 2009 Givens Control Engineering Inc. All rights reserved. 

 

No part of this document may be reproduced, transmitted, transcribed, stored in a 

retrieval system or translated into any language in any form or by any means, 

electronic or mechanical, for any purpose, without the prior express written permission 

of Givens Control Engineering Inc.. 

 

Information in this document is subject to change without notice and does not 

represent a commitment on the part of the vendor. This manual could contain technical 

inaccuracies or typographical errors. 

 

License Agreement 

The software is provided on CD-ROM or diskettes contained in a sealed envelope. By 

removing the diskettes or CD-ROM(s) from this envelope, you indicate acceptance of 

the following terms: 

You may make a backup of the software contained on the diskettes or CD-ROM for 

archival purposes only. You may install the software on one computer per licence. 

Any other duplication of this software or of the software contained in the DataLogger 

enclosure is a violation of law. You may not reverse engineer, decompile, or 

disassemble either software. You may not reverse engineer, or copy the design of the 

DataLogger product, nor sell or loan the DataLogger product to persons that you know 

intend to do so. 

 

Limit of Liability 
In no event shall Givens Control Engineering Inc. or its suppliers be liable for any 

damages whatsoever (including, without limitation, damages for loss of business 

profits, business interruption, loss of business information, or any other pecuniary 

loss) arising out of the use of or inability to use this product, even if Givens Control 

Engineering Inc. has been advised of the possibility of such damages. Because some 

provinces / states / countries do not allow the exclusion or limitation of liability for 

consequential or incidental damages, the above limitation may not apply to you. This 

product includes the items listed in Chapter 1 "Checking Your Package". 

 
Trademarks & Copyrights 
Windows, Windows 95, Windows 98, Windows ME, Windows NT, Windows 2000, Windows XP, 

Windows Vista, MS-DOS and Excel are trademarks of Microsoft Corporation. Analyse-Plus was 

developed using LabVIEW™, Copyright ©2002 National Instruments Corporation.  All Rights 

Reserved. 
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Safety Information 
 
Although the DataLogger CVF2 offers some protection in the event of 

accidental connection to high voltages (see Appendix B 

“Specifications”), deliberate connection of this unit (excluding the AC 

adapter) to voltages in excess of 50 volts represents a misuse of the 

DataLogger unit for which Givens Control Engineering Inc. 

disavows any liability whatsoever. 
 

Do not exceed the operating limits listed in Appendix B 

"Specifications". 

 

To prevent electrical shock when high voltages are accidentally 

applied to the signal input terminals of the unit: 
 always use the AC adapter with a 3-terminal AC electrical outlet            

having a functioning ground (earth). 

 if the AC adapter is not in use, a cable capable of carrying at least 

20 A (amperes) must be connected between the DataLogger 

grounding post (to the right of the carrying handle) and a 

functioning electrical ground (earth). The grounding post is 

identified on the unit by the symbol at left. 

 check that voltages present at the input terminal blocks are not 

hazardous before touching the connected signal wires or the input 

terminals directly, and before making contact through an 

electrically conductive device such as a metal screw driver. 

 never exceed the operating limits listed in Appendix B 

"Specifications". This can damage the unit and expose the operator 

to a shock hazard. 

 if the over-voltage or isolation voltage limits given in Appendix B            

"Specifications" were exceeded or if the unit is malfunctioning in 

any way, the unit must be immediately disconnected from any 

source of electrical voltage and must not be used again until it has 

been returned to Givens Control Engineering Inc. for repair. 

 do not operate the unit in explosive atmospheres. 

 do not immerse the unit in liquids nor splash liquids upon it. 

 do not remove the cover of the unit nor disassemble the unit. There 

are no user-serviceable parts inside. 

 do not expose the unit to extreme heat or substantial mechanical             

damage, which could cause the Lithium-Ion or Lead-Acid gel 

battery in the unit, containing corrosive substances, to leak. 

 do not dispose of the unit by combustion because the internal 

battery may explode when exposed to extreme heat. 

 provide at least 8 cm (3 inches) of air space on all four sides and the       

top of the unit for proper ventilation. 

 follow proper operating procedures as described in this manual, to 

!
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avoid possible hazardous situations. 

 

 

 

Safety Symbols 
The symbol at left indicates that the operator must refer to an explanation 

in this manual. 

 

 

 

The symbol at left indicates a protective conductor terminal (grounding / 

earth post) to be connected to an electrical ground (earth) if the AC 

adapter is improperly grounded or is not in use. 

 

 

!
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Regulatory Information 

This equipment has been tested and found to comply with the limits for a 

Class A digital device, pursuant to part 15 of the FCC rules. This Class A 

digital apparatus meets all requirements of the Canadian Interference-

Causing Equipment Regulations. These limits are designed to provide 

reasonable protection against harmful interference when the equipment is 

operated in a commercial environment. This equipment generates, uses 

and can radiate radio frequency energy and, if not installed and used in 

accordance with this instruction manual, may cause harmful interference 

to radio communications. Operation of this equipment in a residential 

area is likely to cause harmful interference in which case the user will be 

required to correct the interference at his or her own expense. 

 

This equipment is intended for use in an industrial/commercial 

environment only. 

 

Changes or modifications to the equipment not expressly approved by 

Givens Control Engineering Inc. could void the user's authority to 

operate the equipment. 

 

Cet appareil numérique de la classe A respecte toutes les exigencies du 

Réglement sur le matérial brouilleur du Canada. 
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About This Manual 
This manual contains information concerning the installation of the 

Analyse-Plus software and first use of the DataLogger CVF2. Detailed 

information concerning usage of the software is contained in the On-

Line Help. To access this, click the Help button on any display or press 

the F1 key. Once you have installed the software and have become 

comfortable with the hardware, you should use the On-Line Help as your 

main source of information. 
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Getting Started 
 

 

 

 

 

Thank you for purchasing Analyse-Plus and optionally the DataLogger 

CVF2 data acquisition unit. The DataLogger CVF2 is designed and 

manufactured by Givens Control Engineering Inc. . Analyse-Plus was 

created by Givens Control Engineering Inc. 

 

 

New in Version 4.00 
General 

V4.00 is now a fully 32-bit multi-threaded application and runs under 

Windows 95/98/ME/NT4/2000/XP/Vista. The driver was completely 

rewritten from scratch so it can communicate with the Data Logger 

CVF2 under all of these operating systems. It consumes less of your 

CPU's (processor's) resources (execution time) to run. 

 

Plots, importing, DDE, capturing the plot image and data collection have 

all been improved. 

 

Long filenames are supported. 

 

Your serial number for Analyse-Plus now contains information to enable 

or disable optional features or to allow usage of options for a trial period 

(e.g. 30 days). Technical Support can do this merely by emailing you a 

new number. Software validation prevents fraud without the use of a 

dongle. 

 

Data Collection With The Data Logger CVF2 

An anti-aliasing digital filter has been added to the firmware in the Data 

Logger CVF2 (DL). Virtually any choice of filter time constant 

(including zero) is possible. The value is entered as a ratio to the sample 

period so that it doesn’t need to be updated every time the sample period 

is changed. 

 

The DL can now perform pre-triggered collections (in addition to post-

triggered and not triggered available in V3). This means that you can 

configure the DL to collect for x seconds/minutes/hours before a specific 

set of conditions occurs that interests you. For example, you could set the 

1 

What's New 
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DL to wait for a specific upset in a pressure to occur but to collect and 

save the sampled data starting 30 sec before that event so that you could 

determine the cause. The criteria are checked 1000 times/sec. Pre-

Triggering can be done in stand-alone mode to allow you to disconnect 

your PC and leave the DL to check for the event of interest. The Pre-

Trigger Advance time is subject to available RAM in the DL. 

 

If the serial number of your DL is 1114377 or greater, your DL has 512K 

RAM rather than the traditional 256K RAM. But the firmware only 

recognized 256K. Version 4 will automatically upgrade the DL’s 

firmware stored in EEPROM to allow the above features and to enable 

the extra memory. This allows longer stand-alone collections (with your 

PC disconnected and removed) and longer Pre-Trigger Advance times. 

 

When the DL is waiting for the Pre-Trigger or Post-Trigger criteria to be 

met, the green “COL” LED now flashes. When counting down the post-

trigger delay, it flashes at a faster rate. When collecting data, it stays lit. 

In all previous versions, it stayed lit for all 3 conditions. 

 

Comments can be entered at any time during a collection. They are saved 

in the data file and log file when the collection ends or the maximum file 

size reached. Under V3, they were saved at the beginning of collection 

and could not be edited during a collection. 

 

The maximum file size has been increased from 150,000 to 250,000 

samples per channel. (Data collections up to 4.27 billion samples/channel 

can still be configured but will be spread across several files). 

 

When connecting to the Data Logger (DL), the Windows print queue is 

checked to see if the parallel port is in use. This is more reliable than the 

old method, which used hardware. 

 

An IRQ (Interrupt Request) for the parallel port is no longer required. 

This eliminates one of the principal causes of communication errors. 

 

The range and status pull-down lists are now initialized to agree with the 

current selection rather than the top-most choice. 

 

Collection Plot 

The Collection Plot now sizes & shifts itself for video resolutions greater 

than 800 X 600 to use the entire screen. 

 

The y-axis scale precision is set individually for each channel according 

to the magnitude of the values at any time. In V3, they were fixed at 3. 
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Overlay and Separate Plots & Printing 

The plot setup window has been redesigned. You can clear all settings 

and move file names/Tags up and down to allow insertion of one file 

between others. New plot statistics have been added. 

 

The statistics can be toggled to apply to the whole file like in V3 or to the 

viewed region. For example, part of a file may represent one condition 

(e.g. auto) while another may represent another (e.g. manual). You can 

easily compare the statistics of any region (e.g. 2-sigma) merely by 

zooming to it. 

 

Three new options for displaying Fourier plots were added. You may 

choose to have the x-axis linear with respect to period or frequency (in 

V3, it was always linear with respect to frequency). You may display the 

“intensity” of each frequency/period as power or as amplitude on the y-

axis (like variance VS sigma). In V3, it was always amplitude. When 

power is selected, scientific notation is used (e.g. 1.1 E-3). The value can 

be displayed as a vertical bar like in V3 or the dots can be connected like 

in a Time Series plot to provide a different visual effect. 

 

You can now copy the printable image (like a “clean-screen”) to the 

clipboard or save it as a graphics file to BMP, PNG, or JPEG format or 

hold it to allow capturing using your own method. PNG files are very 

compact without loss and are ideal for reports, emailing etc. and are 

compatible with word processors, email and web browsers etc. Various 

color-depth settings are allowed. 

 

You can now copy the data from any plot including the analysis plots 

(cross/auto correlation, Fourier, etc.) to the clipboard as text to allow 

pasting to any application. You can choose which plot, whether to send 

the entire plot’s data or just the viewed portion, period, frequency/time 

index etc. 

 

When printing, a print dialog box is displayed so you can select the 

number of copies etc.. 

 

In V3, you could only print to the default printer and a proper 

Disconnection with the Data Logger (DL) would occur if the default 

printer used the parallel port to which the DL was connected. Now, you 

may choose the printer so you can print to a network or USB port or use 

the print-thru port to print to a printer connected to the parallel port. 

Analyse-Plus will check what printers are available that do / do not use 

the port. 

 

The up/down buttons of the cursor diamond now move the cursor from 

one trace to another (in V3, they had no function). 
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Overlay Plot/Print 

You can now override the scaling of each plot relative to the others. For 

example, you can set several traces to have the same span on the monitor 

in engineering units rather than individual auto-scaling. This allows you 

to visually compare variability. The span, offset and overlay of plots can 

be set independently, for example, to plot the setpoint of a loop on top of 

the measured value. 

 

The spacing between legend items in the printout was reduced and 

statistics were moved so that all 10 items in the legend are printed. All 10 

statistics and y-axis labels are also printed (V3 would only show the 5 

items that you selected to be visible). 

 

You can now toggle between displaying the Tag, Status and Units VS the 

Descriptions. Descriptions are more useful when presenting plots to a 

wider audience who may not know the Tag numbers. 

 

The y-axis labels are now dynamically positioned to centre them with 

respect to the tick marks regardless of the number of traces present. 

 

The Overlay Plot now sizes & shifts itself for video resolutions greater 

than 800 X 600 to use the entire screen. 

 

Switching the legend from Plots 1-5 to 6-10 and back is now much faster. 

 

Separate Plot/Print 

The Separate Plot now sizes & shifts itself for video resolutions greater 

than 800 X 600 to use the entire screen. 

 

The height of each plot (displayed or printed) has been increased up to 11 

% for the same video resolution. 

 

The x-axis scale of auto-correlation and cross-correlation plots has been 

changed from lags to time units (msec/sec/minutes etc.) to make them 

easier to use. 

 

Importing ASCII (Text) 

Much wider files (more columns) can now be imported. 

 

The date and time when the data contained in the text file was collected 

can be entered once during importation and applied to all variables 

imported. The date and time defaults to the date and time of the text file. 

In V3, each data file (one per variable) had to be edited to set the correct 

date & time. 
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Import handles files containing lines that end with line feeds (LF) or 

carriage returns (CR) only. These are typically created in other operating 

systems such as QNX, Unix, etc. 

 

DDE 

Larger files can be sent via DDE. You can send the data in chunks by 

entering the first and last sample number to be sent or, if sending to a 

spreadsheet program, DDE Send can automatically do this, updating cell 

& row numbers automatically for each chunk. 

 

Additional items have been added to DDE Send such as the comments, 

signal (mV/mA/Hz) and Engineering Units scaling values etc. 

 

Importing For Bailey (CLS) 

This is a new optional feature available at extra cost. It imports a Bailey 

CLS (text) file while parsing your template file to obtain Tag, 

Description, Units, variable type info etc. It checks for collection errors 

and replaces them. It checks for multiple breaks in the data collection, 

finds the collection date and time and updates it for all 24 files. It 

suggests filenames for all 24 variables based on their Tags and the 

method you specify. It works on Windows/DOS/QNX CLS files. Contact 

sales@givenscontrol.com for more information. 

 

Save and Export 

File sizes are now displayed in terms of the number of samples instead of 

bytes. This is consistent with Analyse-Plus in general. 

 

Miscellaneous 

The Quick List now displays the number of files in it. The maximum 

number of files has been increased from 200 to 300. 

 

Analyse-Plus is now distributed on CD-ROM. 

 

The default window and plot colours have been updated to make them 

more distinguishable. 

 

Seconds are included in the display of collection time where space 

permits (use 24 hr format).  

 

When exiting, the number of unsaved files is displayed as a warning. 

 

 

New in Version 3.00 
The entire application has been rewritten from scratch. Many new 

features have been added including handling of up to 200 files at a time, 

improved plotting, zooming, DDE, auto and cross-correlation plots, 

mailto:sales@innovin.com
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collection of an unlimited number of samples by continuous streaming to 

disk, better memory management in the DataLogger and more. Search 

for DOS in the On-Line Help for the most important changes to features 

that existed in the previous DOS version. 

 

 

The DataLogger CVF2 represents a new development in data acquisition 

technology — the combination of portability and industrial robustness. 

Here are some of the principal features: 

 

 Input signals are isolated to 1500 VDC. Over-voltage protection is 

300 VDC. 

 Portability, Light weight: 5 lb/2.5 Kg. 

 Plugs into your PC or PS/2 parallel (printer) port. 

 No plug-in card required. 

 High resolution 16 bit A/D. 

 Microprocessor-based with built-in memory. 

 Print-thru port — print while connected to the DataLogger. 

 Battery backup and automatic charging allows operation for 10 

hours on a fully charged battery for units with a Li-Ion battery. 

 8 differential analog input channels, 1 frequency channel. 

 9 analog input ranges: 0 to 20 mA, 0 to 10 V, 0 to 2 V, 0 to 500 

mV, 0 to 100 mV, -5 to 5 V, -1 to 1 V, -250 to 250 mV, -50 to 50 

mV. 

 Built-in anti-aliasing hardware filter for analog channels. 

 Built-in anti-aliasing digital (software) filter for analog channels. 

 0 to 30 KHz frequency channel range with 2 trigger levels. 

 All analog ranges and frequency trigger levels are software 

selectable. No jumpers or switches. 

 10 KHz sampling frequency — 1000 samples/second per channel to 

1 sample/minute per channel. 

 Stand-alone collection mode. After data collection is initiated from 

your computer, collection will continue with or without a computer 

connected. Data can be retrieved later from memory. 

 Advanced collection post-triggering on any channel with 

configurable delay. 

 Advanced collection pre-triggering on any channel with 

configurable advance. 

 Continuous data collection (streaming to disk). 

 Full-featured data collection and time series analysis software 

included. Software runs under Windows 98, 95, ME, NT4, 2000, 

XP or Vista. See Computer System Requirements 3 pages ahead. 

 Included software provides plotting, Fourier analysis (frequency 

spectrum), auto & cross-correlation, import and export capability 

for sampled data (to use in other applications), tag database record, 

collection log file record, editing, filtering and math functions, copy 

DataLogger CVF2 
Features 
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graphic image or textual data to clipboard, export graphic image to 

graphics file. 

 

 

 

The isolation of signal inputs is intended as a safety feature to protect 

the user and equipment from the accidental application of over-

voltage. The isolation and over-voltage features of this product are 

not intended to protect against the deliberate application of extreme 

voltages, such as those above 50 V. 
 

 

 

 

Before you install the software and power up the DataLogger, you should 

spend a moment to understand the format and conventions used in this 

manual. 

 

This manual is written in a tutorial format but can be used as a reference 

also. 

 

Short Forms 
DL is a short form for DataLogger, both in this manual and in the 

software. 

 

Text Conventions 
Specific text that you should type as written or appears explicitly in the 

displays is printed in bold. For example, if this manual says to type 

example, you should type the letters "example". 

 

A placeholder for text ("fill-in-the-blanks") is printed in italics. For 

example, when this manual says to type filename.CSD, you should type 

the name of a file followed by ".CSD". 

 

Commonly Used Words 
Collection is the process of sampling voltage, current or frequency 

signals and converting the samples to numbers. 

 

Frequency when in reference to an input signal, refers to the number of 

voltage cycles per second. The short form for cycles/sec is Hz. When in 

reference to sampling speed, it is the number of samples taken per 

second. In common usage, the short form for this is also Hz. To avoid 

confusion, samples/sec or the sampling period in msec (milliseconds) is 

used in this manual instead. 

 

About This Book 

!
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Period is the arithmetic inverse of frequency. If the frequency of a signal 

is x Hz, then its period is 1/x seconds. If the sampling frequency (or rate) 

is x samples/sec then the sampling period is 1/x seconds. Sampling period 

is written in terms of msec throughout this manual and the software. 

 

Special Information for Windows NT/2000/XP/Vista 
Users 
The software runs under Windows 95, 98, ME, NT, 2000, XP & Vista 

(32 bit). The symbol at left indicates special information for Windows 

NT, 2000, XP or Vista users. 

 

 

Take time now to check that you have received everything you should. If 

you purchased the DataLogger CVF2, you should have: 

 1 DataLogger (with battery unit built-in), 

 1 AC Adapter - 115 Volt, 

 1 Parallel communication cable, 

 1 CD-ROM containing Analyse-Plus, 

 1 User's Guide (this manual), 

 1 optional DC power connector if you ordered it. 

 

If you only purchased Analyse Plus, or if you purchased a software 

upgrade to the DataLogger Collection & Analysis software, you should 

have: 

 1 CD-ROM containing Analyse-Plus, 

 1 User's Guide (this manual), 

 

An upgrade from Version 2.0x (DOS) to 3.0x (Windows) or from 3.0x to 

4.0x includes an upgrade to the DataLogger’s internal software 

(firmware) that resides on an EEPROM. Analyse-Plus will automatically 

detect that the firmware needs upgrading and will automatically perform 

this upgrade. Analyse-Plus will notify you that this will happen and 

provide instructions to you.  This will be done when you first Connect to 

the DL after installing Analyse-Plus. 

 

If you have purchased any optional software add-ons, they will be 

included on the CD-ROM and automatically installed. If anything is 

missing, please email Technical Support immediately. The address is 

located in Appendix A. 

 

 

Update information and errata that could not be included in the manual at 

the last printing is included in the README.TXT file. This is a text 

(ASCII) file included on the CD-ROM. You should examine this file 

using a text viewer or editor before installing the software in case there is 

Late-Breaking 
Information 

Checking Your 

Package 
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information that applies to you. 

 

This file will be copied to your hard disk by the installation program for 

future reference. 

 

 

 

 

To run Analyse-Plus, you need at least a Pentium 200 MHz PC running 

Windows 95, 98 or ME with 32 MB RAM memory or under Windows 

NT4, 2000 or XP with 64 MB RAM memory or Vista with 512 MB and 

30 MB free hard disk space. Only 32 bit versions of XP & Vista are 

supported. Your video card resolution must be set to a minimum of 800 

X 600 pixels. If set to a lower resolution (e.g. 640 X 480), the displays 

will not fit on the screen. 

 

Your parallel port no longer needs to support interrupts. The surest 

setting for your parallel port is Standard Port. ECP or Enhanced usually 

are compatible. Bi-directional may or may not. On most computers, you 

can change this with the computer manufacturer's setup program in 

Windows. 

 

 

 

You may find that the bottoms of graphs are easier to see if you set the 

Windows Taskbar to “floating”. To do this, click on the Windows Start 

button, click Settings and Taskbar & Start Menu. Turn on the check- 

boxes named Always on top and Auto hide. 

 

 

Users who purchased a DataLogger (DL) do not need to have it 

connected to install the software. However, the DL requires about 10 

minutes to reach constant operating temperature (warm-up), so it's best to 

connect it and power it on now. Also, it may be required when Analyse-

Plus is first run after installation to upgrade the DL’s own internal 

software that resides on an EEPROM. 

 

Computer System 
Requirements 

Windows Setup 

Connecting the 
DataLogger 
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The following diagrams illustrate the physical layout of the DL and its 

connections: 

 

 

The LEDS on the DL have the following meanings: 

AC - on when AC power is supplied (from the adapter) if the power 

switch is on; 

BAT - on when the DL is powered from the internal or external battery, 

flashing when the battery is almost exhausted and no AC power is 

connected; 

PT - on when the print-thru port to the printer is selected and ready for 

use. You can print through the print-thru port at this time; 
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Communication between the DL and the computer is not active; 

COL- will flash once per second while waiting for the Trigger Criteria to 

be met, and 4 times per second when counting down the Post-

Trigger Delay. Once collection of sampled data actually starts, it 

will stay on; 

END -on when the DL has finished collecting (is not collecting now but 

has completed a collection since being powered on). 

 

If you are using the DL with a portable or laptop computer, you may 

wish to place the computer on top of the DL. The DL is roughly the same 

length and width as most portable computers. A comfortable arrangement 

is to place the DL with the LEDS facing you, the terminal block at the 

back of the computer and the cable connections at the left of the 

computer. 

 

This diagram indicates how to connect the DL to your computer: 

 

1) To connect and power on the DL, do the following: 

2) Turn off your computer and printer. 

3) If a printer is connected to the only parallel port of your computer, 

disconnect the printer cable from that port. 

4) Connect the male end of the supplied parallel communication cable 

to your parallel (printer) port of your computer. The parallel port is 

always a "D" shaped female 25 pin connector. The male end of the 

cable is the end having the pins extending out of the connector. 

5) Connect the female end of the supplied parallel communication cable 

to the connector on the DL labelled "To Computer". There is only 

one connector that will accept it. 

6) If a printer is available, connect the printer cable to the DL. This 

cable normally connects the printer to the computer. Now it will 

An external DC supply can 

power the DL. To connect 

this, you must purchase the 

optional DC plug specially 

designed for this purpose. It 

plugs into the same jack as 

does the AC adapter. 

 Up to 8 analog 

signals. 

1 frequency 

parallel print-thru 

cable (to printer) 

Data- 

PC computer 

parallel communication 

Parallel (printer) 
port 

A.C. Adapter or optional 

DC plug. 

(not req’d if 

Printer 

(optional) 

signal. 

battery charged) 

cable 

Logger 

CVF2 
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connect the printer to the DL. The DL connector is labelled "Print-

thru". There is only one connector that will accept it. 

7) Power on your computer and allow it to boot (start). 

8) Plug the end of the supplied AC adapter into the DL. Plug the AC 

adapter into a standard AC wall outlet. Note that the AC adapter is 

normally 115 VAC unless you specifically requested 220 VAC. The 

adapter is labelled to indicate which type it is. It is recommended 

that you always plug the AC adapter into a 3-prong (grounded) AC 

outlet. Note: if the AC adapter is not in use (when the battery is 

fully charged or the plug for an external DC supply is used), a 

cable capable of carrying at least 20 A (amperes) must be 

connected between the DataLogger grounding post (to the right 

of the carrying handle) and a functioning electrical ground 

(earth). 
9) Power on the DL. 

10) Power on the printer. The printer is optional at this point. 

11) Check that the AC LED on the DL is illuminated. If not, check that 

you have correctly connected both ends of the AC adapter and that 

the AC outlet has power. If the LED still fails to illuminate, call 

Technical Support. See Appendix A. 

 

Your DL is now running. You do not need to connect your analog and 

frequency signals at this point. The next step is to install the software. 

 

 

Before proceeding, please check that your computer meets the "Computer 

System Requirements" listed previously in this section. Note the video 

resolution requirements. 
 

To install the software, insert the CD-ROM into the computer’s CD-

ROM drive, click the Windows Start button, click Run and enter the 

following: 

d:\setup.exe 

where d is the drive letter of the CD-ROM. Then click OK. 

 

Follow the prompts for the installation drive/directory. If you are 

upgrading, you should install the new version in a new directory. The 

new version will read all file formats of all previous versions except 

Fourier Files. When you first run the new version after installing, your 

hard drive(s) will be searched for any older versions. If one is found, you 

will be asked if you wish to move the Tag Data Base File, Log File, and 

data files (.CSD) to the new location. For example, if the old location 

was C:\APLUS300\DATA and you installed to C:\APLUS400, then 

you'll be asked if you wish to move them to C:\APLUS400\DATA. The 

new version will be able to read data files from the older versions 

whether or not you decide to move them — moving them is only for your 

Installing the 
Software 

You cannot manually 

install the software - you 

must run SETUP from 

the CD-ROM. 

The "AC Power" LED 

will not illuminate if 

the DL is operating on 

its internal battery or 

an external 12 VDC 

source. 

!
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own convenience. 

 

Note that Versions 3.00 and 4.00 will upgrade the DataLogger’s (DL) 

internal software (on EEPROM) so earlier versions will no longer 

communicate properly with the DL. 

 

The installation drive should have at least 30 MB free — more if you 

plan to perform many collections unless you keep the data files on 

another drive. 

 

After installation is complete, click on the Analyse-Plus icon in the 

DataLogger for Windows program group. Before doing so, if you are 

using a portable computer, make sure you have AC power connected 

and all power saving features are turned off. Otherwise, the 

calculation concerning your computer's speed will be affected! 

 

You will be asked to enter your name, your company’s name and a 3 

letter short form for your company name or work area. The latter is used 

to generate the default name of your Log File Path & Name, Tag 

Database File and the prefix part of your Data File Name Prefix/Suffix. 

In each case, the first three letters of these filenames will be the short 

form you entered. You can change any or all of them at any time after 

installation is complete. You must also enter your Analyse-Plus serial 

number found on the CD-ROM or its case and you must agree to the 

terms if you wish to proceed with installation. 

 

After you enter these values, your hard drive will be searched for older 

versions. If any are found, you will be informed and the configuration 

information of the older version will be read. 

 

If you had installed the current version over (in the same directory as) the 

older version, then the installation is complete. If not, you will be asked 

if you wish to move the Tag Data Base File, Log File, and data files 

(.CSD) to the new location (as mentioned above). Analyse-Plus will be 

able to read data files from the older versions whether or not you decide 

to move them — moving them is only for your own convenience. 

Moving the Tag Data Base & Log files is highly recommended. 

 

 

Note that the older version 

may not be able to read files 

from the newer version. For 

example, the DOS version 

2.0x will not read files 

created by the Windows 

version 3.00 but versions 

3.00 and 4.00 can read each 

other’s files. Also, Versions 

3.00 and 4.00 will upgrade 

the DataLogger’s (DL) 

internal software (on 

EEPROM) — earlier 

versions will no longer 

communicate properly with 

the DL. 
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If you purchased Analyse Plus (without a DataLogger), you may skip this 

entire section. If you are using the software for a trial period (typically 30 

days) without the DataLogger, this section is applicable although the 

physical DL is simulated. 

 

If you do not have a built-in parallel port, you may purchase one. Our 

web site (www.givenscontrol.com/no_pport.htm) provides detailed 

options. 

 

Click the Connect button on the centre of the main display. If 

communication is established, this message will be displayed: 

Communication has been established. The serial number of the 

DataLogger is xxxx. 

where xxxx is the actual serial number. (This number is also stamped on 

the bottom of the DataLogger). The firmware (software) version number, 

amount of RAM and how many samples can fit in the RAM are also 

displayed. If this occurs, skip the following section as your firmware has 

already been updated. If the word simulated appears, your DL is being 

simulated and no communication through the parallel port will be 

attempted. 

 

 

If Communication With The DataLogger Is Not Working 
If you are using a Quatech SPPXP-100 Express Card parallel port, 

Windows or its driver does some “checking” or “initialization” for 

approx. 10 sec after the card is inserted into the PC. When this is 

happening, communication with the DL will be disrupted if attempted. If 

the DL is connected, the PT Led will flash during this interval. Wait until 

the flashing stops before clicking Connect. 

 

The most common reason for this is that the portable computer’s AC 

power was not connected or power- saving features were running when 

you first ran Analyse-Plus, causing an erroneous CPU speed calculation 

or that the parallel port type is not set to a compatible type. 

 

To correct the former, click the menu selections Options / 

Communication Settings and click Recalculate. Click OK and 

Connect again. If this does not solve the problem, use the Help topic 

Trouble Shooting to direct you to a solution. In some cases, you may 

need to exit the software, change the parallel port settings through a 

manufacturer’s configuration program or from BIOS (when booting the 

computer) to Standard Port. 

 

 

Connecting To 
The DataLogger 
For The First Time 
And Performing A 
DataLogger 

EEPROM Upgrade 

http://www.givenscontrol.com/no_pport.htm
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Upgrading the DataLogger’s EEPROM Software 
Using the DL’s firmware (software) number obtained when 

communication was initiated, Analyse-Plus will determine if the 

firmware, stored in its EEPROM, needs to be upgraded. If you are not 

upgrading Analyse-Plus, this will not occur. An upgrade from any 

version to Versions 3.0x or 4.0x requires an upgrade to the DL’s 

software. 

 

If an EEPROM upgrade is necessary, carefully follow the instructions to 

completion. The process normally takes only a few seconds but should 

not be interrupted. 

 

 

Completing the First Connection 
Click the Monitor menu. A window should appear showing each of the 9 

channel measurements in terms of the signal magnitude (mV, mA, Hz or 

counts) and in Engineering Units (EU) (L/sec, GPM, % etc.). If you have 

not connected a live signal to the DL’s terminal block, the readings may 

vary erratically. This is normal. If the Signal and EU values are shaded 

(greyed-out) then you have not connected. Click the Connect button in 

the centre of the main window. 
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Performing Your First Collection 
 

 

 

 

This chapter explains how to collect sampled data from your analog and 

frequency signals using the DataLogger (DL). If you purchased Analyse 

Plus without a DataLogger, you can skip this chapter. If you are running 

the software under a trial period (usually 30 days), without a DataLogger 

(DL), the measurements from the DL will be simulated. You should still 

follow through this chapter since it will show the functionality of the DL. 

 

If you have exited Analyse-Plus, execute it again, turn on the DL and 

click the Connect button in the centre of the main window. 

 

 

To illustrate the main collection functions, you should connect at least 

two signals for measurement. The DL has 8 analog and 1 frequency 

measurement channels. Each analog channel can measure voltage or 

current. The frequency channel can measure signals in the 0 to 30 KHz 

range. The analog channels have several built-in measurement ranges. 

However, the minimum and maximum measurable voltages are -5 V and 

+10 V respectively. The minimum and maximum measurable currents 

are 0 and 20 mA. You should choose your signals to be measured with 

the above limits in mind. 

 

The signals that you want to measure must be connected to the terminal 

block on the DL. The voltage and frequency terminal inputs are high-

impedance inputs whereas the current terminals are low impedance (see 

Appendix B - Specifications). When connecting your voltage and 

frequency signals, you need not, in general, worry about the DL 

damaging the device producing the signal to be measured, or vice-versa. 

That's because the DL includes built-in isolation to 1500 VDC and over-

voltage protection to 300 VDC (see Appendix B "Specifications"). (The 

vast majority of data acquisition devices available for PC's typically 

provide 30 to 50 VDC of isolation / over-voltage protection). However, 

you should be careful not to connect these signals to the current 

measuring terminals since your device providing these signals may be 

sensitive to the lower impedance. You should also know that the 

impedance across voltage or frequency terminals is less when the DL is 

powered off (see Appendix B "Specifications"). 

2 

Connecting Your 
Analog and 
Frequency Signals 
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Positive Voltage
Common

Positive Current

Terminal Block

for one channel

Positive Wire of Signal

Common Wire of Signal

+
V

C
O

M

+
I

 

Note: The isolation of signal inputs is intended as a safety feature to 

protect the user and equipment from the accidental application of 

over-voltage. The isolation and over-voltage features of this product 

are not intended to protect against the deliberate application of 

extreme voltages, such as those above 50 V. If the AC adapter is not 

in use, a cable capable of carrying at least 20 A (amperes) must be 

connected between the DataLogger grounding post (to the right of 

the carrying handle) and a functioning electrical ground (earth). 
 

 

The DL provides a similar level of isolation and over-voltage protection 

for current inputs. However, when connecting current inputs, more care 

is required. If there are other devices using this same current signal, you 

will have to break that current path in order to pass the current signal 

through the DL for measurement. You should verify that whatever 

process or experiment that is currently using that measurement will not 

be adversely affected. Also, you should check that the device providing 

the measurement can supply the full range of current to be measured 

under the total impedance of the circuit. To do this, assume a value of 

250 Ohms for the input impedance for current measurements in the DL. 

Then calculate the total impedance of the circuit and consult the 

documentation for the device. 

 

To protect the DL against high current, the current input circuit will 

automatically open if the current rises above approximately 80 mA. 

 

To connect a voltage 

signal to the DL: 

1. Choose which 

channel to use 

(channels 1 through 

8 are for analog 

signals). 

2. Connect the wires to 

the terminals on the 

terminal block for 

the channel you 

chose as in the 

diagram at right. 

 

 

!
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Terminal Block

for one channel

Positive Wire of Signal

Common Wire of Signal

Positive Voltage
Common

Positive Current

+
V

C
O

M

+
I

Line 1

Line 2

Terminal Block

for Channel 9

Wire 1 of Signal

Wire 2 of Signal
~ ~

To connect a current 

signal to the DL: 

1. Choose which 

channel to use 

(channels 1 

through 8 are for 

analog signals). 

2. Connect the wires 

to the terminals 

on the terminal 

block for the 

channel you 

chose as in the 

diagram at right. 

 

To connect a frequency signal to the DL:  

Connect the wires to the terminals on the 

terminal block for channel 9 as in the 

diagram at right. The polarity does not 

matter. Note: the polarity could later 

influence your selection of frequency 

channel trigger level when you setup 

the channel inputs in software. See 

"Setting Up Frequency Channel 

Inputs" later in this chapter. 
 

After connecting one signal, you should use the above procedure to 

connect at least one more so that the collection features that require 2 or 

more signals can be illustrated. 

 

 

 

At this point, the DL should be running, connected to your computer and 

have at least 2 signals connected to it. You should also have successfully 

started Analyse-Plus as explained earlier in this chapter and have clicked 

the Connect button, successfully initiating communication between the 

DL and your computer. You will not need to connect a printer to the 

print-thru port at this time. 

 

 

Setting Up Analog Channel Inputs 
To setup the channel inputs, in the Collection menu, click on Set-Up 

Input Channels. This window allows you to enable channels you will be 

using and to enter the configuration information for each channel. The 

top half of the display is for inputting the following: 

 Enable/Disable each channel 

Using Analyse-
Plus to Collect 

Sampled Data 
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 Tag (the variable name), 

 Description (of the variable), 

 Units — the engineering units of the variable. 

 

The bottom half of the display is for inputting the following: 

 Status (of the variable) — for documentation purposes, 

 DL Input Range — sets the hardware input range in the DL, 

 Signal Lo — signal (mV, mA, Hz, counts) value corresponding to 

EU Lo, 

 Signal Hi — signal (mV, mA, Hz, counts) value corresponding to 

EU Hi, 

 EU Lo — the value in eng'g units corresponding to Signal Lo, 

 EU Hi — the value in eng'g units corresponding to Signal Hi. 

 Mode Select — for frequency channels, specifies whether the binary 

counts (pulses) should be measured as counts or as frequency (Hz). 

 

First, enable the channel(s) to which you will connect the signals to be 

measured. 

 

Tag 
The Tag is the variable name in short form (up to 12 characters). In 

industrial applications, a typical Tag would be "FIC-1207". The Tag is 

the main identification parameter for each variable and so the word "Tag" 

is treated as a synonym for "variable". 

 

All of the information you enter for each Tag is stored in a Tag Database 

File (TDB for short). This data is referenced by the Tag. When you click 

on the Tag pull-down list, all of the Tags you have previously used 

appear. Selecting a Tag will display the configuration information last 

used. 

 

If this is a new Tag, simply enter the name. You should choose a unique 

Tag for each signal that you measure so that the setup information for 

each signal can be uniquely stored in the TDB. 

 

Description & Units 
These are for documentation purposes only. 

 

Status 
This refers to the status of the Tag and is meant to help you document 

your work. Select from the pull-down list or enter text. For example, if 

this is a control loop, you may want to enter "Auto", "Manual", or 

"Bump" etc. here. In other applications, you may wish to document the 

test conditions of your experiment.  

 

The DL, when operating 

with DOS versions, kept 

sampled data in memory 

from all channels whether 

or not you wanted to keep 

this data. Under the 

Windows versions (3.00 & 

4.00), the DL only keeps 

samples data from 

enabled channels so that 

the DL’s memory is not 

wasted. The DL holds up 

to 242688 samples in its 

own memory (512K RAM) 

or 111616 samples (256K 

RAM). So with 2 active 

channels for example, 

under DOS, you could 

only collect 12288 without 

being connected to a 

computer whereas under 

V4, you could collect 

121344 samples. 

Note: Frequency is 

calculated as counts per 

second; in other words 

counts *1000 / sample 

period. 

The Status is optional but is 

very useful for documenting 

your work. 

The TDB is intended to 

help you automate 

your work. Use of the 

TDB is entirely 

optional. 
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DL Input Range, Signal Lo, Signal Hi 
The input range determines the maximum and minimum signal voltage, 

current or frequency corresponding to the full 16-bit resolution of the 

DL. The DL has several signal input ranges available. The ranges and 

corresponding measurement resolution (smallest measurable change in 

signal input) for each range are: 

 

 Range  Filter Cut-off (Hz) Resolution 
       0 to10000 mV  500   0.15       mV 

       0 to  2000 mV 500   0.031     mV 

       0 to    500 mV 500   0.0076   mV 

       0 to    500 mV 4   0.0076   mV 

       0 to    100 mV 500   0.0015   mV 

       0 to    100 mV 4   0.0015   mV 

-5000 to  5000 mV 500   0.15       mV 

-1000 to  1000 mV 500   0.031     mV 

  -250 to    250 mV 500   0.0076   mV 

  -250 to    250 mV 4   0.0076   mV 

    -50 to      50 mV 500   0.0015   mV 

    -50 to      50 mV 4   0.0015   mV 

       0 to      20 mA  500   0.00031 mA 

 

Note that there are 12 voltage ranges and 1 current range. 

 

The frequency channel has one range: 0 to 65535 counts in one Count 

Accumulation Period, or 65535 Hz (Hertz), whichever is smaller. 

 

Generally, smaller ranges are provided so that you get the highest 

possible precision and resolution of measurement even with a very small 

signal. You should always choose the smallest range that will fit your 

signal. For instance, if your signal input was 0 to 1000 mV, for a 

temperature measurement of 10 to 150 deg C, you could choose a range 

of 0 to 2000 mV or -1000 to 1000 mV. Both of these would give more 

resolution and accuracy than the 0 to 10000 mV range. 

 

All of the ranges are software selectable using the pull-down list. There 

are no switches or jumpers in the DL. 

 

The DL Input Range and the Signal Lo / Signal Hi values are related. The 

Signal Lo value is the signal input value corresponding to the calibrated 

EU (Engineering Units) Lo value. Similarly, the Signal Hi corresponds to 

the EU Hi value. The Signal Lo and Signal Hi values are normally the 

minimum and maximum output values of the transmitter, respectively, 

and are determined by its calibration. So in the above example, the 

following values would be entered: 

Tip: the Signal Lo and 

Hi values do not need to 

be the minimum and 

maximum signals you 

will be measuring. They 

only need to be correct 

for the corresponding 

EU Lo and EU Hi 

values. For example, for 

a 0 to 2000 mV range, 

you could enter 500 and 

700 as the Signal Lo and 

Hi but the DL will still 

measure across the 

entire 0 to 2000 mV.  

All of the setup information 

for the entire application 

including the channel setup 

is stored in a configuration 

file in addition to the data in 

the TDB. 
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Signal Lo Signal Hi EU Lo  EU Hi 

    0 (mV)  1000 (mV) 10 (deg C) 150 deg C 

 

When you switch from a voltage range to the current range, you needn't 

worry about the difference in impedance between the two input types. 

That's because there are separate voltage and current terminals on the 

terminal block. The voltage terminals are always high impedance and the 

current terminals are always low impedance — so your signals will not 

be subjected to any impedance change when you change ranges.  

 

The filter cut-off appears in the table on the previous page. Almost any 

signal has some high frequency content, which may be intentionally 

present or may simply be "noise". In any sampling device, it is important 

to remove elements of the signal that are at a frequency faster than half of 

its base sample rate. The purpose of this is to prevent "aliasing" — a 

serious distortion of the true signal when this rule is not followed. Any 

well-designed measurement device will contain an electronic hardware 

filter to remove these elements before sampling takes place. 

 

A filter is designed around the objective of removing specific 

frequencies. The point at which the filter nominally begins this, is called 

the filter cut-off frequency. Frequencies above the filter cut-off frequency 

will be attenuated (reduced). The higher the frequency, the more it will 

be reduced. How the amplitude decreases with frequency is determined 

by the number of poles (or orders) that the filter has. Generally, it is 

considered better to have more poles. 

 

The DL also has an electronic hardware filter. The base sample rate of 

the DL is 1000 Hz so the filter cut-off frequency is 500 Hz. It is a 4-pole 

filter. It will attenuate frequencies at 500 Hz by 34 %. Higher 

frequencies, for example, at 1000 Hz, will be attenuated by 94 % 

(virtually eliminated). All analog ranges are equipped with this filter. 

 

In the table of ranges on the previous page, the smaller voltage ranges are 

duplicated to provide 2 choices of analog filters — 500 Hz and 4 Hz. The 

500 Hz choice is the filter described above. The filter with the 4 Hz cut-

off frequency is a single pole (1st order) filter and is meant for another 

purpose. If you are measuring very low voltage signals, there may be a 

large amount of noise compared to your actual signal. Assuming that in 

these cases you are sampling relatively slowly, you may wish to filter out 

this noise before the sampling takes place. The alternate ranges with the 4 

Hz cut-off frequency are provided for this purpose. When you select 

these ranges, both the 500 Hz and 4 Hz filter are used simultaneously (in 

series). The 4 Hz filter will attenuate frequencies at 4 Hz by 

approximately 30 %, and those at 60 Hz by 95 %. 

 

Analyse-Plus provides a 

software digital filter in 

the computer during 

collection and the DL 

provides one for anti-

aliasing.  See both 

“Setting-Up Math 

Channels” and “Anti-

Aliasing Digital Filter” 

later in this chapter. 

 

You can also perform 

software digital filtering 

after collection. Click 

the Modify menu, 

Perform Math…and 

click Help. 

See Appendix B for filter 

specifications. 
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If you are unsure which filter is right for your application, choose the 

range having the 500 Hz filter. 

 

Select the range and enter the Signal Lo and Signal Hi for the input 

signals you will be measuring now. 

 

EU Lo, EU Hi 
These are the values in Engineering units corresponding to the Signal Lo 

and Signal Hi. These values are used to scale the measurement from 

voltage, current or frequency to any engineering units. For example, if a 

pressure transmitter measured 0 to 100 PSI and its output signal were 1 

to 5 V, then the EU Lo would be 0 and the EU Hi would be 100. (The 

Signal Lo and Signal Hi would be 1000 and 5000 mV, respectively). In 

the example earlier in this section, the EU Lo and EU Hi would be 10 

and 150 respectively. 

 

In some R&D applications, you may not want to use any engineering 

units — you may want to display the measurement in terms of its 

voltage, current or frequency. To do this, just enter the same values for 

EU Lo and EU Hi as you did for Signal Lo and Signal Hi. Then enter the 

Units (see below) of the signal as mV, mA or Hz. 

 

Enter the EU Lo and EU Hi values now. 

 

 

Setting Up Frequency Channel Inputs 
The procedure for setting up the frequency channel (channel # 9) input 

information is almost identical to that of the analog channels. This 

procedure will be explained in terms of the differences. Refer to "Setting 

Up Analog Channel Inputs" earlier in this chapter. 

 

In the Setup Input Channels window, enter the setup information as 

described above for the analog channels, using the TDB when you wish. 

There are only three differences: 

 the frequency channel has no ranges — the range is fixed at 0 to 

65535 counts or 65535 Hz, whichever is smaller, 

 the concept of sampling is replaced by accumulating, and 

 the frequency channel has Trigger Levels, and a Mode Select. 

 

The DL measures frequency by counting pulses or cycles. The number of 

pulses counted in a given time represents the average frequency over that 

time period. The unit of measure of frequency is Hertz (abbreviated Hz) 

and is just a short form meaning "cycles per second". For example, if 

2000 pulses occurred in 0.5 seconds, then the average frequency over the 

two seconds would be 4000 Hz. 
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The DL measures analog channels by taking a snapshot measurement of 

the signal. (All of the 8 analog channels are sampled at exactly the same 

time and held. Then the signals are measured rapidly in succession.). For 

example, if the sample period were one second, then the sampling would 

take place at the same moment at exactly one-second intervals. 

 

The DL measures the signal from the frequency channel by accumulating 

pulses over a time period called the Count Accumulation Period. At the 

end of the Count Accumulation Period, the number of counts is reset. 

The sample value contains the number of counts but can optionally be 

converted to a frequency. This is done by dividing the number of counts 

by the Count Accumulation Period. The Count Accumulation Period can 

be set to any value less than or equal to the Sample Period. When the 

sample value is converted to frequency, the resolution or "granularity" of 

the reading will be lower with small Count Accumulation Period values 

(e.g. less than 1 second). 

 

Mode Select 
In the Set-Up Input Channels window, this specifies whether you want 

the counts to be converted to a frequency (in Hz) or left as counts. 

Regardless of the setting, the result will be scaled according to the Signal 

Lo/Signal Hi and EU Lo/EU Hi. The frequency is calculated as: 

Frequency = counts X 1000 / Count Accumulation Period 

 

This setting also determines the units of the Signal Lo/Signal Hi values 

(and indirectly, the Collection Triggering Limits since they are in terms 

of EU (Engineering Units)). 

 

Note that the above formula also indicates how the resolution of the 

frequency measurement is affected by the Count Accumulation Period, 

especially at a low Count Accumulation Period setting (less than 1 

second). 

 

Range/Trigger Level 
When measuring the frequency channel, the DL needs to have a criterion 

to decide if a voltage change in the signal should be considered a pulse. 

That criterion is called the trigger level. The trigger level specifies how 

much the voltage must change to be considered a new pulse. If you have 

no information about the size of the pulses in your signal, you should 

first try using the default (lowest) trigger level. You can then verify that 

triggering is occurring and that the measurement is correct using the 

Monitor window. If it is incorrect, try the higher trigger level. Generally, 

the higher frequency measurement is the correct one. 

 

Due to the design of the DL, the trigger level that is most appropriate 

may depend on the polarity of the wires if your signal has a pulse (rather 

The Count Accumulation 

Period is normally entered 

when you choose the 

Sample Period in the 

Start/Stop Collection 

window. 
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than square or sinusoidal) shape. You may need to try both trigger levels 

in the manner described in the previous paragraph. 

 

You select the trigger level in the same way as you did the ranges for the 

analog channels. 

 

Enter the Signal Lo and Signal Hi in the same way as you did for the 

analog channels. Since the frequency channel can be set to measure 

counts or frequency (see Mode Select above), these values should be 

entered in the same measurement units (counts or Hz). The value must be 

between 0 and 65535 (the fixed input range of the frequency channel). 

 

 

Exiting the "Set-Up Input Channels" Window and Saving the 

Configuration 

Click on OK. All set-up data is saved. 
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Setting Up Math Channels 
Math Channels are pseudo channels that calculate data from one or more 

input channels. If you are mainly interested in testing the data collection 

hardware and software at this time, you may wish to cover this topic 

later. 

 

Generally, a math channel has one sample for each sample of the input 

channels. In other words, if you are collecting 10000 samples, the math 

channels will also collect 10000 samples. Math channels are configured 

by entering equations. For example, designating the input channels as s1 

through s9, a simple equation for math channel 1 would be: 

s2+s3. 

A more complex equation would be: 

sine(butterworth,l,1,1,2,s1-2/s3*sqr(s3/s8)) 

 

If you enable m input channels and n math channels, then each collection 

will yield m+n files. In other words, math channels do not replace the 

input channels. 

 

First, click Set-Up Math Channels from the Collection menu. Then 

enable any channel to use (1 to 9). Enter a formula in the Current 

Formula box or double click on a previously entered formula in the 

Formula History box. Edit the formula or use Function Select to build 

the formula using the computer’s prompts. 

 

The library of available functions is extensive. Some functions cannot be 

used during a collection. These functions were designed to work with the 

Perform Math on a Quick List File window in the Modify menu. 

 

The On-Line Help contains extensive documentation on the use of math 

functions including a description and mathematical specification of each. 

 

Example Function: Digital (Software) Filtering 
Digital filters are one commonly used group of mathematical functions. 

They are intended to provide software filtering of collected data in 

addition to the hardware filtering discussed in "DL Input Range, Signal 

Lo, Signal Hi" earlier in this chapter. The hardware filters only apply to 

analog channels whereas software filtering can be done on any channel. 

 

The principal application for a digital filter is to smooth the signal by 

reducing noise or variability of no interest. Guidelines for choosing 

filters are in the Help topic How To Filter A File. 

 

Unless you have special needs, a good choice for a filter is the 

Butterworth filter with the order set to 1 or 2. An order of 1 will have the 

same effect as a common exponential (first order) filter used in most 

Math channels did not exist 

prior to version 3.00. They 

provide all the functionality 

of the Processing options in 

those versions plus much 

more. 

In version 2.04, this was a 

Processing option and 

allowed a separate filter for 

each channel. In earlier 

versions, there was one 

digital filter for all 

channels. 
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industrial computer systems. This is also the same type used prior to 

version 3.00. 

 

To create a digital filter, click on the Setup Math Channels function in 

the Collection menu. Enable a math channel you wish to use. Click in 

the formula window for that math channel. Click the Function Select 

button and select Filters. Choose the filter type, order and cut-off 

frequency. You must enter the last parameter, which defines the Input 

Channel to filter (s1 through s9). Note that a low-pass filter keeps low 

frequencies and high pass keeps high frequencies. 

 

You can also filter signals later (anytime after collection is finished) by 

clicking Perform Math on a Quick List File from the Modify menu. 

 

 

Exiting the "Set-Up Math Channels" Window and Saving the 

Configuration 

Click on OK. All set-up data is saved. 

 

 

Verifying Your Channel Setup and Measurement 
After you have connected the signal wires and entered the channel setup 

information, you will want to verify that the measurement is correct. You 

can then be confident that you have good wire connections and proper 

setup information. 

 

To do this, click the Monitor menu. If you are performing your first 

collection, you should select this function now. 

 

The display shows the present measurement of all channels in mV, mA 

or Hz, and the equivalent value in engineering units. The sampling of 

these signals is independent of the collection sample period in the 

Start/Stop Collection window (documented later in this chapter). The 

analog measurements are "snapshots" taken every 0.5 sec. The frequency 

measurement is based on a 1 second Count Accumulation Period and so 

represents the total counts or average frequency over the previous 1.000 

seconds ending within 1 second ago. For a description of how the DL 

measures the frequency channel, see "Setting Up Frequency Channel 

Inputs" earlier in this chapter. 

 

If the frequency measured by channel 9 is greater than 65535 Hz, the 

maximum frequency measurable by the DL, then "Overflow" will be 

displayed instead. Note that the DL’s hardware is designed to provide 

reliable measurement up to 30000 Hz; higher measurements may occur 

and may or may not be exact. 

 

Square Root Compensation 

is another commonly used 

function for converting 

differential pressure to flow. 

See the Help topic Square 

Root Extraction for more 

information. 
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You should verify that the measurements for the channels with signal 

wires connected, are nominally correct. If any values appear incorrect, 

check that you have connected the wires correctly and that you have 

entered the channel input setup information correctly. For analog 

channels, be sure to check the polarity, as well. For frequency channels, 

be sure to try the other trigger level. 

 

This display also shows the collection status and progress at all times. 

Click Detail to list additional channel setup information. 
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Setting Up and Starting the Collection 
To setup the collection parameters in preparation for collection, click on 

Start/Stop Collection in the Collection menu. If the display is greyed-

out (shaded) then the computer is no longer communicating with the DL. 

If so, click on the Connect button in the centre of the main window. 

 

In this window, you can perform the following actions: 

 modify the Data File Path, Name Prefix and Name Suffix which, 

together specify the name and location of the data files that will 

contain the sampled data; 

 modify the Log File name which keeps a record of your work; 

 enter comments to document your work, 

 specify the collection sample period; 

 specify the collection Count Accumulation Period for frequency 

channels; 

 specify the number of samples to collect; 

 specify the Anti-Aliasing Digital Filter Time Constant Ratio; 

 specify that a new Triggered collection should be started 

immediately when the current collection ends; 

 start the collection; 

 stop the collection; 

 start a triggered collection. 

 

 

Data File Path, Name Prefix, Name Suffix & Log File 
The 3 items in the box just above the centre of the window concern file 

names used for saving collection data. The Name Suffix will be zero if 

this is your first collection. The names of the files that will hold your 

sampled data (data files) are created by appending the Data File Path, 

Name Prefix, Name Suffix and a letter a through r. The letters designate 

the channel number (a is input channel 1, i is input channel 9, j is math 

channel 1, r is math channel 9). The file extension is always .CSD. The 

Name Suffix is always a 4-digit number and specifies the filename to be 

used next. 

 

For example, if the data file path/prefix is "C:\APLUS400\DATA\JKS" 

and the numeric suffix were 59, then the name of the file containing the 

data from channel 2 would be: "C:\APLUS400\DATA\JKS0059B.CSD". 

 

If you wish to start a new project or area of study, you may wish to 

change the Name Prefix and zero the Name Suffix. 

 

The Log file records a summary of your work. To view the log at any 

time, click the File menu and select View/Search Log File.  

 

To print the Log File, 

double click on the file in 

the C:\APLUS400\DATA 

directory in your Windows 

Explorer. This will normally 

open the file with Notepad 

or WordPad. Select Print 

from the File menu there. 

For more information about 

these files, click the Help 

button in this window. 
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Comments 

This is strictly for documenting your work. It is saved in the Log File and 

in each data file. 

 

Sample Period 
The sample period is the period at which samples are taken when the DL 

is collecting. It is expressed in msec (milliseconds) per sample. (Click the 

msec / sec button to switch between msec and sec). Since 1 msec equals 

0.001 seconds, a sample period of 1 means that a sample is taken every 

0.001 seconds or that 1000 samples are taken from all channels every 

second. A sample period of 1000 means that 1 sample is taken on all 

channels every second. 

 

If you wish to think in terms of frequency, remember that frequency and 

period are inverses. To convert frequency in Hz to period in msec, use 

the formula: Period=1000/frequency. 

 

The DL's fastest sample period is 1 msec and the slowest is about 4.2 X 

10
9
 msec (about 50 days). 

  

The DL samples all channels simultaneously regardless of the sample 

period or the number of channels in use. In other words, a sample rate of 

1 msec means that there is a space of 1 msec between each sample of a 

given channel, regardless of how many channels you are using. 

 

You cannot change the sample period while the DL is collecting. 

 

Choosing the Sample Period With Frequency Inputs 
Whereas analog inputs are sampled, frequency inputs (pulses) are 

accumulated. At the end of the accumulation, the pulse count is reset. 

The interval of accumulation and resetting the count is called the Count 

Accumulation Period. The Count Accumulation Period can be set 

independently, but it must be less than or equal to the Sample period. For 

more information see "Setting Up Frequency Channel Inputs" earlier in 

this chapter. 

 

The frequency sample is taken at the same time as the analog samples. 

The frequency sample can be measured in terms of counts, or converted 

to a frequency in Hz, either of which will be scaled to the EU Lo/EU Hi 

you specified. This conversion is specified by the Mode Select specified 

in the Set-Up Input Channels window. 

 

Count Accumulation Period 
The Count Accumulation Period is the interval at which the pulse counter 

for the frequency channel is read and reset. Whereas analog inputs are 

sampled, frequency inputs (pulses) are accumulated by a counter in the 

If you know what sample 

period to use, you can 

skip this section. 

If you don't know what 

Sample Period to use, see 

the Help topic How to 

Choose the Collection 

Sample Period. 
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DL, then read by the DL, then reset. The Count Accumulation Period can 

be set independently of the sample period, but it must be less than or 

equal to the Sample Period. Regardless of the Count Accumulation 

Period, one sample will be generated at each Sample period. 

 

Number of Samples 
This is the number of measurements (samples or points) to collect on 

each channel. The DL can collect in normal or Stand-Alone mode. In 

Stand-Alone mode, the DL can collect as many samples as it can hold in 

its memory. This is a total of 242688 samples (512K RAM) or 111616 

samples (256K RAM) divided among the active channels (26960 

samples per channel if 9 channels are used with the 512K RAM version). 

(The amount of RAM is displayed when you Connect to a different DL 

or Connect for the first time after starting Analyse-Plus). When the 

desired number of samples is collected, the computer reads all of them 

from the DL and saves them to your hard disk. At this point, the 

collection is considered to be finished and you can start a new collection 

if desired. 

 

In Stand-Alone mode, the DL can be disconnected at any time after the 

collection has started (to perform a collection on another DL, to move the 

computer to a safer environment, to take the computer to a printer, etc.). 

When the computer is reconnected, the samples will be retrieved from 

the DL and saved to disk. Remember to click on the Disconnect button 

in the main window before physically disconnecting the DL! 

 

In normal mode, an unlimited number of samples (up to 4.27 billion) can 

be collected in a single collection. The computer repeatedly executes a 

cycle of reading samples from the DL and saving them to your hard disk 

a few thousand samples at a time. This is sometimes called “continuous 

streaming to disk”. If the Number of Samples exceeds the Data File Size 

Limit (set in the Options menu), the collection will span multiple data 

files for each channel. 

 

If you intend to do Fourier analysis, the calculation is far faster if the 

number of samples is a power of 2. This only becomes significant with 

large files (e.g. 65536, 131072 etc.) 

 

When you enter the number of samples, the total time to perform the 

collection is displayed to its right. 

 

Anti-Aliasing Digital Filter 
In any sampling device, it is important to remove elements of the signal 

that are at a frequency faster than half of its base sample rate. The 

purpose of this is to prevent "aliasing" — a serious distortion of the true 

For more information on 

Stand-Alone Mode, see the 

“Stand-Alone Mode” Help 

topic. 

 

DOS versions could only 

operate in Stand-Alone 

mode and could only collect 

up to 12288 samples 

regardless of the number of 

active channels. 

For more information on 

Anti-Aliasing, see the 

“Aliasing — A Simple 

Explanation” Help topic. 

This is new for version 4.00. 
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signal when this rule is not followed. This was briefly discussed earlier in 

this chapter. 

 

The Anti-Aliasing Analog Filter was also presented earlier in this chapter 

and exists in the hardware of the Data Logger CVF2 to remove 

frequencies faster than 2 msec (500 Hz). This is ideal because the Data 

Logger actually samples at a fixed period of 1 msec. To achieve slower 

sample rates that you choose, the Data Logger sub-samples this data. For 

example, to achieve a sample period of 100 msec, the Data Logger keeps 

very 100
th

 sample and discards the remaining 99. 

 

Aliasing can also occur during this sub-sampling (digital sampling). The 

Digital Anti-Aliasing Filter exists to prevent or minimize this. This is 

done by digitally filtering the sampled data every 1 msec before the 

digital sampling occurs. The CPU (processor) in the CVF2 does this. 

 

Use the Anti-Aliasing Digital Filter to prevent aliasing from occurring. 

Enter the time constant of the filter expressed as a ratio to the sample 

period. The value is expressed as a ratio so that you only need to enter 

this value once for all sample periods to achieve consistent protection 

against aliasing. Values from 0.318 to 1.5 are recommended. The cut-off 

period to its right shows the period at which the filter’s effectiveness 

begins. Variability having a lower period (higher frequency) than this 

will be progressively more attenuated. 

 

For example, suppose your sample period is 100 msec. A ratio of 0.318 

gives a time constant of 31.8 msec. The cut-off period is 2 X Pi X the 

filter time constant. In this case, this is 200 msec. Since aliasing will 

occur when variability is present at 200 msec or slower, this is a good 

starting point for the filter setting. The same value will work in the same 

way for any sample period. In this case, variability at 200 msec will be 

attenuated about 30 % while that at 50 msec will be attenuated 82.5 %. 

Note that the effectiveness of the filter increases quite slowly with 

variability of progressively lower periods (called the roll-off). This is 

because a First Order digital filter is used. Contrast this with the Anti-

Aliasing Analog Filter used in the hardware of the Data Logger CVF2. It 

uses a fourth-order analog filter. Generally, higher order filters are 

desirable to provide a faster roll-off. 

 

Start Button 
Click this to start a collection. If it is greyed-out (shaded), either the DL 

is currently collecting or is disconnected. When collection starts, you will 

see the COL ("Collecting") LED on the DL illuminate. 

 

When collection is finished, the END ("Collection Finished") LED on the 

DL will illuminate and the COL LED will switch off. 
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Stop Button 
Collection stops automatically after the selected number of samples have 

been collected. Click this button if you want to stop the collection at any 

time before then. The remaining data collected by the DL will be saved 

to disk, the COL LED on the DL will switch off and the END LED will 

switch on. 

 

Triggered Restart Check-Box & Start On Trigger Button 
The Start On Trigger button is for initiating a collection that will start 

(trigger) before or after (Pre-Triggering VS Post Triggering) the signal 

measurements reach a certain criterion or to delay a collection to start at a 

specific time. This is a very powerful feature and is documented in the 

Set-Up Triggering: Overview topic in the on-line Help. If it is greyed-

out (shaded), either the DL is currently collecting or is disconnected or 

you have not specified any Trigger Criteria or Trigger Delay in the Set-

Up Triggering window. 

 

If the Triggered Restart check-box is checked, then the DL will 

automatically start a Triggered Collection as soon as the current 

collection ends (the next millisecond). (The first sample of the next 

collection will be taken when the Trigger Criteria is satisfied and the 

Trigger Delay expired). This is the same as automatically clicking the 

Start On Trigger button at exactly the right time each time a collection 

ends. When Triggered Restart is on, Stand-Alone mode is not possible. 

However triggered collections (Triggered Restart is off but start the 

collection with Start On Trigger) are still possible in Stand-Alone 

mode. 

 

 

 

Plotting the Sampled Data As It Is Collected 
To use the collection plot, you need to be collecting now or have done a 

collection since starting Analyse-Plus. To start a collection, see START 

above. 

 

From the main menu, click on the Plot menu, then Plot Data As 

Collected. You will see a series of traces, one for each enabled input 

channel. Click the Math Channels button to see Math Channels. (This 

will be greyed-out if you have none enabled). The right side of the graph 

shows the Tag, Units and various identifying information as well as the 

last value plotted (usually the same as the last value sampled by the DL). 

At the bottom of the window, the DL’s collection status is indicated. The 

time indicates when the first sample of the collection was taken by the 

DL. This is true even in the case of Triggered collections whether they 

are Advanced/Delayed by Pre/Post Triggering. It is also true if the 

For more information 

about Triggered 

Collections, see the Set-

Up Triggering or the 

Trigger Restart topics in 

the on-line Help. 

 

You can also configure 

the DL to start a 

collection at a specific 

time — a "Delayed 

Collection". See the Set-

Up Triggering: 

Overview topic in the 

on-line Help. 

 

Pre-Triggering is new 

for Analyse-Plus V4.00. 

It allows starting a 

collection before the 

Trigger Criteria are met 

so that you can 

determine the cause of 

the event. 

 

Note: If you want to 

restart a collection when 

the current one is 

finished without 

checking the Trigger 

Criteria, instead just 

specify a larger Number 

of Samples to collect 

and specify the Data 

File Size Limit if you 

require files of a specific 

size. 
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collection spans multiple data files. 

 

In the lower right, the plot palette is visible. This includes tools for 

manual or auto scaling, zooming in several different ways, etc. When you 

zoom one plot, the new time span will be used in all plots so that they 

remain synchronized. You can also manually scale by clicking on the y 

or x axes labels. Generally, it is easiest to keep the y-axis auto-scale 

locked on and use the palette for zooming the x-axis. 

 

To change the plotting colours, click on the Colors button. 

 

 

 

When the Collection Ends 
If the DL finishes collection, the remaining samples from the DL are 

saved to your hard disk. If Triggered Restart is on, a new collection will 

be started as soon as the last sample of the current collection is sampled.  

 

If you have disconnected the DL during a Stand-Alone collection, then 

the sampled data will be saved to disk when you click the Connect 

button once again. Until that time, the samples will remain in the on-

board memory of the DL. Do not power off the DL until the samples 

have been saved to disk. The samples will be lost if you do so! 

 

If you were performing a normal (not Stand-Alone) collection, the data is 

saved to disk as it is collected. 

 

 

Exiting Analyse-Plus 
To exit, first click the Disconnect button in the centre of the main 

window. Then from the File menu, choose Exit. You will be warned if 

you have files that you have modified but not saved. 

 

Never turn off your computer when running this application. Always exit 

and shutdown Windows properly. 

Never power off the DL until the sampled data has been saved to your 

computer's hard disk. Click on the Disconnect button in the main 

window. 

 

 

Important Tip: To get 

the most out of the DL, 

it is important to 

understand Standalone 

mode. More information 

is available in the Help 

menu. 

The on-line Help has a 

more detailed description of 

the palette. 

 

Tip: If you want to plot 

sampled data from a 

previous collection you 

need to you use Plot Quick 

List Data from the Plot 

menu. This also allows 

printing. See the Help. 

Unlike the DOS versions, 

your configuration and 

TDB files are saved at 

various times when they 

change, rather than once 

when you exit the 

program. 
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Key Features And Tools 
 

 

 

 

The main reference for Analyse-Plus including DataLogger CVF2 data 

collection is the on-line Help. This chapter provides a brief overview to 

help you start using the software quickly. Use the Help for any questions 

you may have. 

 

 

The Quick List is simply the list of files that are open or available for 

immediate use. It holds 300 files. When you open a file, it appears at the 

top of the list. When you modify a file, it will move from its present 

location in the Quick List to the top. 

 

A divider labelled “Recently Collected Files” exists part way down the 

list. When data files are created via data collection, these files appear 

under the divider. When the Quick List becomes full, recently collected 

files will drop off the list. You can open them again if you wish to work 

with them. Files that you have modified but not saved will never drop off 

the list (unless you have 300 of them!). 

 

The number of files above or below the divider is flexible but space for 

20 is reserved for recently collected files at the bottom. 

 

Analyse-Plus is designed to work with multiple files. For example, the 

Open window allows you to open 280 files at a time (300 minus 20). 

You can also Save, Import, Export, Plot, Analyse and perform Math on 

several files at once. 

 

 

To plot and analyse data, first make sure the files of interest are in the 

Quick List (see above). Then click on the Plot menu, then Plot Quick 

List Data.  

 

The main features of plotting in Analyse-Plus are: 

 Time Series, Fourier (frequency spectrum), Integrated Fourier, Auto-

Correlation and Cross-Correlation plots; 

 Traces can be plotted separately (1 trace per graph up to 4) or 

overlaid (up to 10 traces in different colours on the same time or 

3 

The Quick List & 

Multiple Files 

On-Line Help 

Tip: Open (in the File 

menu) allows you to select 

multiple files, an entire 

directory or multiple 

directories. The first 280 

.CSD files will be opened. 

Plotting And 

Analysing 
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frequency axis); 

 The x-axis of Fourier and Integrated Fourier plots can be scaled in 

terms of frequency (standard) or period (non-standard). If set to 

frequency, it can be labelled in terms of frequency or period and 

switched at will; 

 The amount of overlap of traces in Overlay plots can be specified; 

 Both axes can be manually or automatically scaled; 

 Both axes can be linear or log; 

 The plot can be dragged with a mouse to “scroll” through the data; 

 A grid can be displayed; 

 Various statistics can be displayed on the plots; 

 Statistics can be calculated from the entire file or from the viewed 

region only; 

 Colours can be configured for clarity or according to taste; 

 A cursor can be placed on any of the 10 traces and the value in 

Engineering Units with the time/frequency/period are displayed; 

 Six zoom/unzoom modes are available; 

 Printing can be done in colour or B&W without configuring colours 

(even if using a colour printer); 

 For B&W printing, you have control over the substitution of grey 

tones for colours to distinguish traces. 

 The graphic image can be copied to the clipboard or exported to 

BMP, PNG or JPEG graphics file formats. 

 The data plotted in any graph can be copied as text to clipboard. 

 

First choose the Plot Pattern (Overlay-Time, Overlay-Frequency or 

Separate). Select the Axis Scaling (linear or log). Choose the Plot Type. 

Click on the QL buttons at left to choose your files from the Quick List 

(hold down the Shift key to select multiple files or drag the mouse while 

holding down the Shift key). If you are plotting a Cross-Correlation, use 

the QL buttons at right to select the second file. Choose the % Overlay 

(overlap of each trace) for Overlay Time plots. Choose the statistics you 

wish to display (1
st
 Statistic, 2

nd
 Statistic). 

 

If you are plotting any Fourier or Integrated Fourier plots there are 4 

options to allow you to customize the presentation to your taste. The first 

affects both the presentation and the numeric result slightly whereas the 

others only affect the presentation. They are: 

 Window For Fourier (Hamming, Blackman etc.) for preventing 

“leakage” from one sample to another; 

 Fourier Scale can be set to Amplitude or Power. Power = 

Amplitude
2
 / 4 (much like choosing between standard deviation and 

variance in statistics); 

 Presentation to draw the amplitude/power at each frequency/period 

as a vertical bar or to connect each point; 

The On-Line Help includes 

topics to assist in 

interpretation of Fourier, 

Auto-Correlation and 

Cross-Correlation plots. See 

the How To topic. 
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 X-Axis Linearity to space the plotted data in terms of linear/log 

frequency or linear/log period on the x-axis. If set to frequency, the 

x-axis can be labelled in terms of period or frequency units. 

 

Click the Plot button. 

 

The plot palette in the lower right corner of the plot(s) is the key to 

getting the most out of the plotting and analysis functions. Zooming is 

perhaps the most important (icon in top row, second from right). The 

Help has a point-and-click guide to palette functions. 

 

Click on the Stats button to see statistics for the entire file (extents) or 

the viewed region. 
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Only plots can be printed. To print the Log File, use NotePad, WordPad 

or your favourite editor or word processor. 

 

If you are printing through a network, USB or a serial port or have not 

physically connected the DataLogger to the computer’s parallel port (in 

other words, the printer is currently plugged into the parallel port), 

simply click on the Print button in a Separate or Overlay Plot. There, 

select whether you wish to print a colour or B&W image (normally 

depends on whether you are printing to a colour (usually InkJet) or B&W 

(usually laser) printer and set the Output to Printer. Click OK and the 

standard print dialog box will appear allowing you to choose the number 

of copies etc. 

 

You may print while using the DataLogger (DL) through a network, USB 

or serial port or, in most cases, to the parallel port. Printing through 

anything except the parallel port is straight forward — if you are 

currently “Connected” (PC is communicating with the DL because you 

clicked on the Connect button), you will be asked if you intend to print 

using the parallel port used for communication with the DL (say No). If 

you do not see this message, it is because you have no printer objects 

configured to use such ports. You should configure them first using the 

Windows Control Panel. 

 

If you wish to print through the parallel port, connect the DL to the 

computer’s parallel port and connect the printer to the DL. When the PT 

LED (Print-Thru LED) on the DL is on, all printing traffic from all 

applications will pass through the DL on to the printer without 

intervention by the DL. 

 

The PT LED, when on, indicates that the computer and DL are not 

communicating (not Connected in communication). Click the Connect 

button in the centre of the main window to initiate communication. 

Connection will be successful if the parallel port is not in use by 

Windows (or any application) for the purpose of printing. (If busy, you 

will be notified). When you click on the Print button in a Separate or 

Overlay plot, and all of your printer objects are configured to use the 

parallel port or you indicated that you want to print using the parallel 

port, a Disconnection with the DL will be done if possible. This is the 

same as clicking the Disconnect button on the main window — it stops 

communication to allow printing. Click the Connect button when 

printing is done and you are ready to work with the DL again. 

 

Disconnection may not be permitted if you are performing a type of 

collection that requires constant communication with the computer for 

the purpose of saving sampled data to disk. Specifically, disconnection is 

permitted if you are not performing a collection or if the DL can operate 

Printing 
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in Stand-Alone mode. You can know this in advance of attempting to 

print by looking in the bottom half of the Start/Stop Collection window; 

it indicates if Stand-Alone mode is possible and whether the DL is idle or 

collecting. 

 

A benefit of operating the DL in Stand-Alone mode is that you can 

print and collect data at the same time. 

 

 

To copy the Overlay or Separate plot image to the clipboard or export it 

to a graphics file (to include it in a document or merely to save it), click 

on the Print button at the bottom of either of these plots. 

 

Choose the Print/Image Color and Output. For JPEG, there is a direct 

relationship between image quality and file size. For PNG, higher 

compression does not affect the image quality. It just makes the files 

smaller, requiring slightly longer to create them. 

 

PNG files are often 20 times smaller than BMP files and are 

recommended for all uses. 

 

The Color Depth determines how faithfully the colours are represented 

in the file or clipboard. 8-bit normally suffices. 24-bit is better in some 

cases but results in larger files. 

 

Click OK. For graphics files, the default file name is chosen from the 

path and name of the first file in the plot. 

 

 

To copy the plot data as text to the clipboard for pasting into another 

application, click on the Copy button at the bottom of the Overlay or 

Separate plots. 

 

Select the file you want to copy and whether you want to copy the entire 

plot or only the viewed region. 

 

Click OK. 

 

 

Analyse-Plus includes approximately 50 math functions. Calculations 

can be performed during a collection from DataLogger CVF2 input 

channels or at any time from Quick List files. 

 

In the first case, the calculations are done by employing Math Channels. 

The channels are configured by clicking Set-Up Math Channels from 

Math Functions 

Copying the Plot 
Image to the 
Clipboard or 

Exporting It 

The PNG file format is 

recommended for all uses. It 

is results in a far smaller 

file than a BMP file and a 

better image (“loss-less”) 

than a JPEG file. Even an 

MS Word document is 

usually smaller when 

importing a PNG file than 

copying & pasting. 

Copying the Plot 
Data to the 

Clipboard 
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the Collection menu. There, you enter formulas that calculate one value 

for each sample of one or of many input channels. The names s1 to s9 

denote the 9 input channels. Formulas are entered with function names, 

+, -, *, /, brackets etc.. For example, this is a valid formula: 

3*s1-sine(4*s2/(9.345-s5)) 

 

Functions that require knowing future sample values or whose 

calculation results in a different number of samples than existed in the 

input are not allowed in Math Channels (they will be greyed-out). 

 

One of the most useful Math function groups is Filters. 

 

To perform calculations on files in the Quick List, click Perform Math 

on a Quick List File from the Modify menu. Click the Modify button to 

assign different Quick List files to the variables s1 to s10. Then, enter the 

formula in the Current Formula box. 

 

In both cases, the easiest way to enter formulas is by clicking on the 

Function Select button. A window will appear, on the left of which 

appear the various function groups and on the right, the functions for 

each group. When you double-click on a function, a window appears 

with entries to complete. When you click OK, the function is inserted in 

the Current Formula. There, enter the function input in the space 

provided (s1 through s10). Click on Help to get an explanation of each 

function 

 

In both cases, a Formula History allows you to choose from the last 20 

formulas you created. Just double-click on the formula you wish to use. 

Click Clear Formula first if you want to erase the existing formula. 

 

Click OK on the bottom of the window to execute the calculation. 

 

 

You can edit all attributes of a data file such as Tag, Description, Status, 

etc., as well as the samples themselves. Choose Edit from the Modify 

menu and select the desired file from the Quick List. Edit any item. 

 

If you wish to save it to a new file, change the filename at the bottom of 

the window. If you wish to keep the changes in the same file, do not 

change the filename. In either case, your changes will not be permanent 

(irreversible) until you select Save or Save As from the File menu. 

 

 

This command can be found in the File menu. To save one or more files, 

click on Save or Save As. Click on the files in the Quick List that you 

Editing 

Saving 
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wish to save. Hold down the <Shift> key to select multiple files (drag the 

mouse for a group of consecutive files). The rightmost column in the 

Quick List indicates if the file has already been saved (not yet modified). 

If you select a file that has already been saved, Analyse-Plus will simply 

ignore that file.  

 

Click OK in the Quick List and again in the Save / Save As window. If 

you chose Save, you will be prompted for a filename and location only if 

the file is new (files created using Perform Math on a Quick List File 

or DDE Receive are new). If you chose Save As, you will be prompted 

for every file. 

 

 

You can import ASCII (text) files by clicking on Import From ASCII in 

the File menu. The result is a .CSD (data) file. To export a .CSD  (data) 

file, click on Export to ASCII.  Importing and Exporting is usually done 

to transfer data between Analyse-Plus and another application. If the 

other application supports DDE, you may find it quicker to use DDE 

Receive or DDE Send. The Help file contains simple instructions for 

using DDE with Excel™ and other applications. 

 

Importing 

Analyse-Plus can import almost any type of Text file. When you select 

the text file, it will try to determine the delimiters used between columns 

(comma, spaces, etc.) and the type of time data. The text file may have 

no time stamp column, may have one time stamp column that specifies 

the sample period for all columns of sampled data, or it may have one 

time stamp column for each column of sampled data (alternating). The 

time stamp data is only used for determining the sample period. You can 

override the calculated sample period or manually specify the delimiters. 

 

The columns of data do not have to be the same length.  

 

In the last step of importing, specify the desired filenames only for 

columns you wish to import. Remember that each name in the Quick List 

must be unique even if the files will be saved to different directories. 

 

Exporting 

When exporting files, you can choose multiple data files from the Quick 

List if you wish. In this case, you can export them to a single text file 

with multiple columns or to multiple text files (one for each data file). 

Choose the delimiter and the format of the time stamp. 

 

If you are exporting multiple data files to a single text file, the first 

column will be the time stamp (time index) data if every data file had the 

Importing And 

Exporting 
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same sample period. Otherwise, there will be one time stamp column for 

each data file (alternating). 

 

If you are exporting multiple data files to multiple text files, you can save 

time by selecting Use Source With New Extension. This will choose the 

directory (folder) and filename of each text file automatically. The folder 

of the text file will be the same as the data file and the filename will be 

the same except a .TXT extension will be used in place of .CSD. If you 

wish to explicitly specify the path and filename for each text file, click 

Select New Path and Name. 

 

Exported text files tend to be much larger than the corresponding data 

files. Most users delete them after use. 

 

 

DDE (Dynamic Data Exchange) is a quick and easy way to send or 

receive data between Analyse-Plus and other applications. It is generally 

faster than exporting and importing. 

 

The three DDE functions in Analyse-Plus can be found in the File menu: 

DDE Send 

DDE Receive 

DDE Server 

 

In DDE Send and DDE Receive, Analyse-Plus is a client and the other 

application is the server. In DDE Server, Analyse-Plus is the server and 

the other application is the client. 

 

DDE Send 

DDE Send is used to send data files to other applications such as 

Excel™. You need to know 3 items of information. In the case of 

Excel™, these are the name of the program (“Excel”), the name of the 

workbook or sheet and the row/column location where the data should 

go. The Help contains more specific information concerning use of this 

function. Click Send to transmit the data (“one-shot”). 

 

Prior to Windows 2000, the Windows operating systems limited the size 

of transmissions to 64K. Typically, this limit would be encountered when 

sending 5000 to 6000 samples. The limit can be overcome by sending the 

data in chunks using the First Sample and Last Sample fields to send 

just 5000 samples (approx.) or clicking the check-box at centre-right of 

this menu. The latter setting breaks the data into chunks automatically 

but only works when sending data in row/column format (to a 

spreadsheet). 

 

DDE 
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DDE Receive 

DDE Receive is used to receive individual samples or a group of samples 

(may be an entire file) from other applications. In the case of Excel™, 

the 3 items of information you need to know are the name of the program 

(“Excel”), the name of the workbook or sheet and the row/column 

location where the data comes from. 

 

DDE Receive can receive data in a single transmission (“one-shot”) or 

repeatedly (like sampling). The data you specify is received when you 

click the Start Receive button and whenever the sending application 

indicates that the data is new (typically when it changes). When 

transferring data from a spreadsheet, typically the entire data set would 

be transferred at once. In this case, you would click End Receive as soon 

as the First Sample and Last Sample fields change (indicating that the 

transmission has been received). When sampling from an industrial 

computer (typically over a network), the transmitting computer would 

typically send one or a few samples at a time at an interval determined by 

it. The transmitting computer would automatically inform Analyse-Plus 

when the data is new. If you wish to have the data sent at an interval 

independent of the update time of the data, click on This Source and 

enter a different item. This would typically be a sampling trigger, a 

counter or a clock.  

 

In either case, enter the DDE information in the DDE Receive window, 

enter the filename where the data will be saved, click Start Receive to 

begin reception and click End Receive when all the desired data has 

been received. You can then specify a path for the new data file by 

clicking Save from the File menu. 

 

DDE Server 

DDE Server, when activated, stands ready to automatically fulfill 

requests for data from other applications (clients) running on the same 

computer or over a network. 

 

To use this, you need to know the following information (enter or 

configure into the client application): 

The Service is APLUS. 

The available Topics are: 

System 

Specific File 

Collection Status 

Each of the Topics has several Items. See the On-Line Help. 

 

Generally, you first click on DDE Server in the File menu. Click the 

Activate button of any or all of the topics you wish to make available to 

the client. Minimize the window. The Server will remain active until you 
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click on the OK or Cancel buttons. The client must be configured or 

programmed to inquire with a valid Service, Topic and Item.  

 

The System Topic provides a list of available Topics (the remaining 2 

above) plus all of the filenames in the Quick List. The Specific File 

Topic transmits a data file. The filename can be specified by the user by 

clicking the Modify button. A client can also poke the Specific File 

Topic to specify the filename. By using the filenames provided in the 

System Topic, and poking the Specific File Topic, a client could read all 

of the data files in the Quick List. 

 

The Collection Status Topic provides detailed information about the 

progress of the current data collection (with the DataLogger CVF2, if 

purchased). Once the client determines that the collection has ended, the 

client can use the Specific File Topic to read the new files containing 

sampled data. 

 

The above information provides only an introduction to DDE in Analyse-

Plus. The On-Line Help contains the necessary detail to operate it. 

 

 

Some software items are optional. They can be purchased when you 

purchase Analyse-Plus or at a later date. At printing time, these options 

were built into the software. Therefore, they can be enabled at any time 

by changing the software serial number that Technical Support will 

provide after purchase.  

 

Currently, 3 options are available: 

Import Bailey CLS (text data collection files from a Bailey DCS). 

Import QMM (data collection files from a Metso Damatic DCS). 

MatLab .m file (import .csd files to MatLab) 

 

The first two options are intended to automate the process of importation, 

which could otherwise still be done using Import From ASCII in the 

File menu. They can save substantial time. 

 

The third option is useful to MatLab users who wish to import Analyse-

Plus .CSD data files into MatLab. This package includes a matlab script 

“.m” file and a .txt file for documentation. 

 

See the On-Line Help for more information. 

 

Add-Ons 
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Technical Support and Warranty 
 

 

 

 

 

This product includes a two year limited warranty and one year of 

unlimited technical support. (Additional years of technical support can be 

purchased.) 

 

Warranty Terms 
The product consists of the items listed in Chapter 1 "Checking Your 

Package". Givens Control Engineering Inc. warrants that the product, 

exclusive of the internal battery, will be free from defects in material and 

workmanship for a period of two (2) years from the date of shipment. 

Givens Control Engineering Inc. warrants that the internal battery will be 

free from defects in material and workmanship for a period of one (1) 

year from the date of shipment. To the maximum extent permitted by 

applicable law, Givens Control Engineering Inc. disclaims all other 

warranties, either express or implied, including but not limited to implied 

warranties of merchantability and fitness for a particular purpose. 

 

No warranty is expressed or implied for products damaged by accident, 

abuse, misuse, natural or personal disaster, or unauthorized modification. 

 

The entire liability of Givens Control Engineering Inc. shall be, at its 

option, to repair or replace the product or portions of the product that do 

not meet the limited warranty described above. Shipment from the 

customer to Givens Control Engineering, including the cost of shipping 

fees, taxes, duties and customs fees are the responsibility of the customer. 

 

Product returned for warranty or non-warranty service should be shipped 

to: 

GIVENS CONTROL ENGINEERING INC. 

2173 Bonfield Ct., Burlington, ON, 

Canada L7P 2W7 

 

One of the following should be included with the shipment: 

 the software serial # (click Help and About Analyse-Plus from the 

main window menu, or 

 the hardware serial # (displayed when you click the Connect button 

A 
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on the main window). 

 

Before shipping the unit, make sure that the problem cannot be solved by 

other means. Contact Technical Support and provide the information 

listed below. 

 

Important: Product shipped to Canada from other countries should be 

labelled (on the shipping box) "Returning to Manufacturer for 

Repair/Warranty". If shipping from the USA or Mexico, also mark 

"Made in Canada from NAFTA parts". 

 

 

Technical Support 
This product includes one year of unlimited technical support. 

(Additional years of technical support can be purchased.) 

 

Before calling technical support, make sure you have the following 

information available: 

1) One of the following: 

 the software serial # (click Help and About Analyse-Plus from the 

main window menu, or 

 the hardware serial # (displayed when you click the Connect button 

on the main window). 

2) The operating system you are using; e.g. Windows XP 

3) Computer Model, processor type and speed. 

4) Size of installed RAM memory in the computer. 

5) A complete description of the problem, including what is displayed on 

the screen when the problem occurs and what is necessary to recreate the 

problem. 

 

You may also be asked to email or fax the contents of the Analyse-Plus 

configuration file. The file is called DLPAxxx.CFG where xxx is the 

version number (e.g. DLPA401.CFG). It is in the installation directory 

(normally C:\APLUS401). It is an ASCII (text) file and can be printed 

directly. 

 

You may contact Technical Support by fax, phone, email (internet) or 

mail. 

 

GIVENS CONTROL ENGINEERING INC. 

2173 Bonfield Ct., Burlington, ON, 

Canada L7P 2W7 

Phone: (905)-631-8293 Fax: (905)-631-8761 

email: support@givenscontrol.com 
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DataLogger CVF2 Specifications 
 

 

 

 

Interface: Parallel (printer) port of a PC ATTM or PS/2TM compatible 

 computer. 

Isolation of Signal Inputs (continuous): 1500 VDC, 1000 VAC RMS 

Over-voltage Protection (continuous): 
 Voltage Ranges: 300 VDC, 300 VAC RMS 

 Current Ranges: 350 VDC, 250 VAC RMS (sine) 

Input Impedance Powered On: 
 Voltage: 10 MOhms, 

 Current: 250 Ohms approx., 

 Frequency: 2 MOhms. 

Input Impedance Powered Off: 
 Voltage: 68 KOhms, 

 Current: 250 Ohms approx., 

 Frequency: 68 KOhms. 

Current Input Open-Circuit Threshold: 80 mA. 

Number of Channels: 8 differential analog (voltage or current), 1 

 frequency. 

Analog Input Ranges: 0 to 20 mA, 0 to 10 V, 0 to 2 V, 0 to 500mV, 

 0 to 100 mV, -5 to 5 V, -1 to 1 V, -250 to 250 mV, -50 to 50 mV. 

Frequency Input Range: 0 to 30 KHz. 

Frequency Channel Trigger Levels (approx.): 150 mV, 1200 mV. 

A/D Resolution: 16 bits — (0.0015 % of range). 

Sample Rate: 
 Maximum: 1000 samples per second per channel. 

 Minimum:  1 sample per 49.7 days per channel. 

Maximum Number of Samples: 242688 (512K RAM) or 111616 

(256K RAM) in on-board memory divided among active channels. 

4.29 billion per channel when streaming continuously to disk. 

Sampling Synchronicity: Simultaneous 

Collection Start Triggering: Any 1 to 3 channels with configurable 

 Pre-Trigger Advance or Post-Trigger Delay with AND, OR, 

 SEQUENCE or LATCH operation. 

Analog (Hardware) Filters (Analog Channels): 2 

 Fixed 4 pole, 500 Hz cut-off for anti-aliasing. 

  Attenuation (amplitude):  500 Hz  34% 

        600 Hz  76% 

     1000 Hz  94% 

B 
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     2000 Hz  99.75% 

 Selectable 1 pole, 4 Hz filter for voltage ranges of 0.5 V or less. 

  Attenuation (amplitude):         4 Hz  29% 

         40 Hz  93% 

         60 Hz  95.3%. 

Digital (Software) Filter: For anti-aliasing. Variable from 0 to infinity 

 in 65535 steps. Filtering takes place every 1 msec — after the 

 sampling at 1 msec intervals and before digital sampling to the 

 user’s sample period. 

Range, Analog Filter, Frequency Trigger Selection: Software 

 selectable. No jumpers or switches. 

Physical:  
 Weight: 5 lb, 2.5 Kg. 

 Dimensions: 12” X 9.5” X 3.5”, 30 cm X 24 cm X 9 cm. 

Built-In Battery — Units Sold After Jan 1, 2009 (SN 1114399 and 

higher):  

Type: Lithium-Ion. (Does not need to be discharged before 

charging — no memory effect). 

Switching — Discharging/Charging/Idle: Fully Automatic. 

No user intervention. 

Capacity When Fully Charged: 10 hours of operation. 

Charging Time: 

  Powered Off :   To 100 % Linearly: 8 hr 

  Powered On:    To 100 % Linearly: 14 hr 

 

Built-In Battery — Units Sold Before Jan 1, 2009 (SN 1114398 and 

lower):  

Type: Lead-Acid Gel. (Does not need to be discharged before 

charging — no memory effect). 

Switching — Discharging/Charging/Idle: Fully Automatic. 

No user intervention. 

Capacity When Fully Charged: 4 hours of operation. 

Charging Time: 

  Powered Off :   To 66 %: 2.5 hr To 100 %: 14 hr 

  Powered On:    To 66 %: 4 hr To 100 %: 16 hr 

Calibration: Automatic calibration of input ranges for each channel 

 (with user-supplied reference signal). The software to perform the 

 calibration is not included in Analyse-Plus. Calibration parameters  

 are stored in on-board EEPROM. 

Power Supply: 115 VAC Adapter, CSA/UL Approved. 230 VAC 

 Adapter available as an option. With optional plug, an external 

DC supply can be connected instead (18 to 25 VDC for units sold 

after Jan 1, 2009 or those whose battery was upgraded to Li-Ion, 

11.5 to 25 VDC for older units). 

Ports: 1 parallel I/O port for communication to computer. 1 parallel 
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 Print-thru port that connects to a printer to allow printing from the 

 computer before, during or after collection. 

Signal Input Connections: Terminal block. 

 Analog Channels: Positive voltage, Common, Positive current. 

 Frequency Channels: Line 1, Line 2 

Visual Indicators: 5 LEDS:  AC Power, Battery in use/Battery low, 

 Print-thru enabled, Collecting, Collection finished. 

Case: Impact resistant plastic case with handle. 

Principal of Operation: Microprocessor based. 

Warm-Up Time: 10 minutes. 

Operating Temperature: 0o to 40o C, 32o to 104o F. 

Humidity: 80% maximum, non-condensing. 

 

Although this information is believed to be accurate, we reserve the right 

to make changes without notice. 
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